Microsoft has upped the ante with outstanding new features in Excel 2013, such as recommended PivotTables and charts, Power View, GeoFlow, PowerPivot, and advanced workbook auditing with Inquire. But that is not all! Instead of using VLOOKUP to relate data, users can relate Tables directly using Relationship, and they can now open each workbook in its own Window without losing the ability to copy and paste between other open workbooks. Participate in this session and learn how to put the power of Excel 2013 to work right away.
Introduction
Microsoft has upped the ante with outstanding new features in Excel 2013 – automated analysis with recommended PivotTables and charts, pure power analysis with the Power View and PowerPivot add-ins, and advanced workbook auditing with Inquire. But that's not all! Excel 2013 contains powerful and easy to use new features like Flash Fill, Timelines, Quick Explore drill down and around, Combo charts, and the ability to open workbooks in their own window without losing the ability to copy and paste between workbooks. This session is designed to help you put the power of Excel 2013 to work right away.

Learning Objectives
Upon completing this session, participants should be able to:

• Explain why the new Single Document Interface makes it easier to use Excel 2013 with dual monitors
• Identify three types of automated analyses in Excel 2013
• Use Flash Fill to split, combine, and rearrange data quickly and easily without using commands or complicated formulas
• Describe the new Excel Data Model and explain its impact on PivotTable analysis
• Use combination line and column charts to present financial data more effectively
• Explain why Quick Explore is more effective in exploring the underlying data in a PivotTable report than simple drill-down functionality
• Distinguish between an ordinary PivotTable and one built using PowerPivot
• Describe data visualization and how Power View reports help users better understand business data
• Identify three new Excel functions for retrieving business data from the web
User Interface Updates

The first thing you will notice when you open Excel 2013 is the clean, new look. The icons on the ribbon have been flattened – they've lost their colorful, three-dimensional appearance. The flat, almost colorless icons on the stark white ribbon are designed to deliver added usability and productivity on touch devices. Most of the features that you know and use are still there, along with some new ones that are big time savers. And, of course, the ribbon interface is customizable. If the stark white theme is too bright for your aging eyes, change the theme to light or dark gray. Select File, Options to open the Options dialog box. In the General pane, select the desired Office Theme.

Users will also notice the new Start screen that displays each and every time they open Excel. The Start screen contains links to open existing documents and large "buttons" to create new documents. Users can create a blank document or use one of the many templates stored on the local machine or on the web. While the Start screen is designed to get users working quickly, it can be an annoying interruption for many office professionals. To disable the Start screen, select File, Options to open the Options dialog box. In the General pane, uncheck Show the Start screen when this application starts.

For accounting and finance professionals, the animations in Excel can be very distracting. The cursor seems to float from one cell to another after a noticeable delay. Cells recalculate with spinning numbers like the odometer in an older automobile. Unfortunately, there is no easily accessible setting to turn off this behavior, but there is a Registry key that can disable it. Using Regedit, modify the Windows Registry to enter the following key and DWORD value.

Registry Key: HKEY_CURRENT_USER\Software\Microsoft\Office\15.0\Common\Graphics

DWORD (32 bit) Value: DisableAnimations with its value set to 1

The re-design of the Office 2013 interface, including Excel's, was driven by its anticipated use on touch-enabled devices. To further enhance the touch capability of Excel, there is a new Touch Mode that enlarges the size of the command icon touch area on the ribbon to make icons easier to select, as shown in Figure 1. To use Touch Mode, users must first add the command to the Quick Access Toolbar (QAT). To execute the command, click or touch the Touch/Mouse Mode icon and select the appropriate mode.

Figure 1 – Touch Mode Enlarges the Command Icon Touch Areas of the Ribbon
Better Dual Monitor Support
In Excel 2013, each workbook opens in its own window. Excel 2013 no longer supports the multiple document interface (MDI) and is now a single document interface (SDI) application, similar to Word and PowerPoint. Each workbook is opened in its own window in a single instance of Excel. This makes it easy to rearrange several workbooks on multiple monitors. Since all workbooks are opened in a single instance of Excel, users are no longer prevented from copying and pasting between workbooks as they were when using multiple instances of Excel in prior versions.

On some occasions, multiple instances of Excel may be warranted. For example, users may have very complex workbooks that take a long time to recalculate, contain macros that have long execution times, or have very large data sets or PowerPivot models that consume a lot of RAM. In those situations, opening a second instance of Excel would allow these processes to continue without affecting a user’s ongoing efforts in other workbooks. Right-click on Excel's Taskbar icon, and while holding down the ALT key, click on Excel 2013, as shown in Figure 2. Continue holding down the ALT key until Excel is fully opened or Windows prompts you to confirm that you want to open a new instance.

Automated Analysis
Excel 2013 extends its functionality by automating routine analysis. With automated analysis, such as Quick Analysis, Recommended PivotTables, and Recommended Charts, business professionals can gain the insight they need for running a business quickly and easily.

Quick Analysis
The Quick Analysis tools available in Excel 2013 allow users to format, chart, or tabulate their data with a few clicks. Simply highlight your data and click the Quick Analysis Lens that pops up in the lower right hand corner of the selected data range, as shown in Figure 3. Select the desired action from the Quick Analysis gallery -- Formatting, Charts, Totals, Tables, or Sparklines -- at the top and then click the desired analysis to apply in the pane at the bottom.
Among the most useful of the automated analysis functionality in Excel 2013 is Recommended Charts. This feature produces a gallery of pre-configured charts from data selected by a user. A user simply scrolls through the gallery to select the chart that best presents the data given their reporting objectives. Recommended charts can be further customized to meet a user’s needs and are available from the Quick Analysis Lens or the Insert tab on the ribbon, as shown in Figure 4.

Figure 4 – Accessing Recommended Charts from the Ribbon

Figure 5 displays a gallery of recommended charts produced by Excel 2013. As a user scrolls through the gallery of pre-configured charts on the left, the pane on the right displays a full-sized preview of each selected chart. To complete the charting process, simply select a chart, click OK, and then add a title and any other customizations desired.
Recommended PivotTables

PivotTables provide quick, easy, and accurate data summarization and analysis with drill down to the underlying details. Nothing is more powerful in Excel than PivotTables, but many accountants and financial professionals don't use PivotTables because they are unfamiliar with the functionality. Excel 2013 attempts to ease the burden of learning how to use this functionality with Recommended PivotTables. Similar to Recommended Charts, Excel produces a gallery or pre-configured PivotTables, from which a user need only make a selection. However, in K2's experience, the PivotTables produced by this functionality are the simplest of reports that do not provide meaningful analysis. While Recommended PivotTables are a good start at trying to automate the PivotTable building process, this functionality is much less useful than expected. The bottom line is that users must master essential PivotTable processes in order to harness their power.

Producing a recommended PivotTable is similar to producing a recommended chart. Highlight the data, including the field names, or use a Table for the data, and click **Recommended PivotTables** on the Insert tab. From the gallery of PivotTables, select the one that best summarizes the data and click **OK**, as shown in **Figure 6**. The PivotTable may then be customized and formatted to meet a user’s needs.
Recommended PivotTables looks to the format of the fields in the data set in determining what type of data is stored in each field. If a text field is formatted with the Accounting format, Excel gets confused and displays the error message shown in Figure 7. To overcome this problem, reformat text fields by applying the General format and repeat the process.
Slicers for Tables
Think of Slicers as end-user filters. Slicers have been available to filter PivotTables and PivotCharts since Excel 2010. Now they are available for filtering Excel Tables, and can even be used to filter Tables connected to external data sources. To apply a Slicer to a Table, place the cursor in the data and then select Insert, Slicer on the ribbon. In the Insert Slicers dialog box, check the fields that you desire to filter in the Table and click OK to create the Slicers, as shown in Figure 8. Arrange, format, and apply styles to Slicers on the Slicer Tools, Options contextual tab.

![Insert Slicers dialog box](image)

Figure 8 – Applying Slicers to a Table

Timeline Filters
Timeline filters in Excel 2013 are similar to slicers, but are used to filter date fields in PivotTables. If you are using PivotTables to analyze transactional data, every record in your data set will have a date associated with it. Usually, dates are grouped into months, quarters, or years for reporting and analysis. Date grouping adds another layer of complexity that makes it more difficult for less knowledgeable users to create and manipulate PivotTables. That’s where Timelines come in to play. Simply click in a PivotTable and select Timeline from the Insert tab to produce a Timeline filter as displayed in Figure 9. To change how the data is grouped (months, quarters, or years), click the drop-down in the upper right hand corner of the Timeline control. To filter the PivotTable, click on a period button, such as Q1, Q2,
etc., or drag your mouse across the Timeline to select multiple periods. The selected period is displayed in the upper left hand corner of the control.

Figure 9 – Using a Timeline to Filter Dates in a PivotTable

Flash Fill
Flash Fill is a new data manipulation feature that allows users to split, combine, or rearrange data quickly and easily without using commands or complicated formulas. Whether it’s rearranging customer contact names, inserting parentheses and hyphens in telephone numbers, or separating account numbers and account names in a QuickBooks trial balance, Flash Fill can get the job done, as shown in Figure 10.

Figure 10 – Use Flash Fill to Manipulate Data

There are multiple ways to apply Flash Fill. In default, Excel displays Flash Fill suggestions as you work. As shown in Figure 11, a user has modified the first record and has moved to the second record. As the user begins modifying the second record, Excel automatically displays a suggested flash fill for the column. At that point, the user can press ENTER to accept the suggested flash fill or press ESC to cancel the suggested fill. Alternatively, select Data, Flash Fill from the ribbon or press CTRL + E to execute Flash Fill from the keyboard.
To reformat a list of telephone numbers, type one number as it is to appear with parentheses and a hyphen, press ENTER, and then press CTRL + E. If Excel is unsure of what is to be done for any record, it will skip the record. Move the cursor to a skipped record and "correct" it, and then press CTRL + E to fill similar records. Continue this process until the entire column has been updated.

Here's a few tips for using Flash Fill effectively:

- Flash Fill does not create formulas related to the original records, so the original data column can be deleted without impact on the fill column.
- The fill column need not be adjacent to the column that contains the data to be manipulated, but make sure that there are no blank columns between the original data and the intended fill column.
- Flash Fill cannot be used to transform numbers. For example, Flash Fill cannot be used to divide a column of numbers by five. Use formulas instead.
- A column can be filled from any record in the column. If the first record contains ambiguous data, use another record to demonstrate how the data is to be manipulated and then press CTRL + E to force the execution of Flash Fill.
- Flash Fill is a pattern recognition engine, not a logic engine. Flash Fill cannot be used to convert state names to state abbreviations because it does not recognize that UT and LA are the abbreviations for Utah and Louisiana, respectively. Use Custom Lists or a VLOOKUP table instead.

**Improved Charting**

Excel 2013 improves and extends charting functionality. The Chart Tools contextual tab has been consolidated from three tabs to two to make it less confusing and easier to work with. Formatting and customization of chart elements are now performed in a sidebar named the Formatting Task Pane that is opened from the context-sensitive menu. Chart elements can be selected, chart styles applied, and chart data filtered from three chart buttons that appear to the right of a selected chart, and Recommended Charts, covered earlier, makes it easier for users to select a chart that best presents their data.
Chart Buttons and the Formatting Task Pane
Whenever a chart is selected, three chart buttons appear immediately to the right of the chart, as shown in Figure 12. The top button allows users to add or remove chart elements; the center button allows users to select a pre-formatted style within the selected chart type; and the bottom button allows users to filter out unwanted data.

Figure 12 – Chart Buttons Allow Quick Customization
Right-clicking on a chart element (chart title, vertical axis, horizontal axis, data series, etc.) displays the context-sensitive menu from which the selected element can be customized on the Formatting Task Pane, as shown in Figure 13.

Figure 13 – Formatting Task Pane Displayed from the Context-Sensitive Menu
Filtering Out Unwanted Data
One of the problems faced by accounting and business professionals when creating charts is having data that doesn’t support the reporting objective. For example, a report exported from an accounting system may display monthly detail, quarterly totals, and an annual total, but the user wants to prepare a chart that presents only quarterly comparisons. That's where the Chart Filter button comes into play. It allows users to filter the underlying data so that a chart displays just what is desired quickly and easily without modifying the report, as shown in Figure 14.

Better Data Labels
Data Labels on charts are dramatically improved. Labels can now be based on computed values in a cell range rather than just a data point’s value, series name, category name, or legend key. This allows users to create advanced formulas to display data labels based on defined conditions. In effect, users can apply "conditional formatting" to Data Labels. In the example shown in Figure 15, any period variance that exceeds 5% of the current period budget appears on the face of a chart that compares YTD...
expenditures to the annual budget by expense category. The chart not only identifies the amount of the annual budget consumed and available, but the data labels draw attention to current expenditures that, left unchecked, may present a problem in the future. All of this information was displayed in a single chart, thereby reducing the amount of time spent by executives in monitoring expenditures.

Figure 15 – Data Labels Based on a Range that Contains Formulas

Combination Charts

Users have been able to create combination charts in all versions of Excel back to Excel 97, but many users were unaware of this capability. In order to create a combination chart in older versions, users would first create a base chart, such as a line chart, with multiple data series. Then, they would right-click on a single data series and select Change Series Chart Type from the context-sensitive menu. This would allow a user to select a different chart type, such as a column chart, for that series, thereby creating a combination line and column chart.

This method for creating a combination chart is no longer functional as described in Excel 2013. Excel now has an explicit Combo chart type from which users can create combination charts. The Combo chart type makes it easier and more intuitive for users to create combination charts, but more importantly, it exposes this functionality to users who may not be aware that combination charts can be created in Excel. Depending on the data, combination charts may be displayed in the Recommended Chart gallery, which gives users one-click access to this advanced functionality.
Figure 16 displays the process for creating a combination column and line chart on two axes. Simply select the Chart Type for each data series and check whether the series should be displayed on a Secondary Axis. Note that this identical chart could have been selected with a single click from the Recommended Charts gallery.

**Figure 16 – Creating a Combo Chart in Excel 2013**

**Improved PivotTable Analyses**

Without a doubt, PivotTables are the most powerful feature in Excel, and they get more powerful in Excel 2013. The biggest innovation is the in-memory data model that allows users to create PivotTables from multiple Excel tables. In the past, this was not possible because PivotTables could only have a single data source. The single data source requirement falls by the wayside in Excel 2013 with the advent of the Excel Data Model.
The Excel Data Model
Microsoft has been widely criticized for limiting its distribution of the premium Excel add-ins, among them PowerPivot, to users who have licensed Office 2013 Professional Plus as part of a volume license agreement or an Office 365 subscription. While PowerPivot is capable of advanced functionality not available in ordinary PivotTables, the biggest advantage of PowerPivot is the ability to create PivotTables and PivotCharts from multiple data sources. While many users will not have access to PowerPivot, all Excel users will be able to create PivotTables from multiple data sources because all versions of Excel 2013 include the Excel Data Model, the core in-memory data analysis component of PowerPivot.

To use the relational power of the Excel Data Model, the data to be analyzed must be stored in Excel Tables. First, convert any ordinary ranges to tables. Keep in mind that tables can also be populated by connection to external data sources, such as the accounting system. Once the data are in tables, start the PivotTable creation process by selecting Insert, PivotTable to open the Create PivotTable dialog box. Enter the name of the first table and make sure to check Add this data to the Data Model, as shown in Figure 17. Click OK to display the PivotTable placeholder and Field List.

![Figure 17 – Creating a PivotTable Using the Excel Data Model](image)

When a table is added to the Data Model, the PivotTable Field List can display all fields from all tables in a workbook. If the tables are not related, relationships can be created on a common field directly from the Field List, as shown in Figure 17. With the Excel Data Model, end users can create PivotTables from multiple related tables, even if the tables themselves are from multiple external data sources.
Notwithstanding the obvious and powerful advantages of building PivotTables on the Excel Data Model, there are several significant disadvantages.

- Grouping of items is not available in a PivotTable built on the Data Model. Neither built-in date grouping nor custom item grouping is available. Calculated fields can be created in the source data to work around this limitation.

- Calculated fields and items are not supported. Calculated fields can be created in the source data as a workaround.

- Drilling to detail only displays the first 1000 records that underlie a summarized cell. PivotTables built on smaller amounts of data are not likely to exceed this limitation.

- Excel 2013 workbooks that use the Data Model are not backward compatible to earlier versions of Excel.

**Relationships**

In the previous example, establishing relationships between tables was accomplished through a link in the PivotTable Field List. A more sophisticated approach to establishing and maintaining data relationships between tables is available through the ribbon. Select **Data, Relationships** to access this functionality, as shown in **Figure 18**.

![Figure 18 – Creating and Maintaining Data Relationships](image-url)
Drill Down and Around with Quick Explore

Users can avail themselves of the enhanced drill down and drill around capabilities of Quick Explore when analyzing data in PivotTables built on the Excel Data Model, OLAP cubes, or PowerPivot. Quick Explore allows users to drill down and around through all fields in the Data Model, even those fields which are not part of the PivotTable Report. The drill through process rearranges and filters the report to provide the data desired, as shown in Figure 19.

Figure 19 – Using Quick Explorer to Drill Down and Around
To use Quick Explore, position the cursor in a cell containing a row or column item and click the **Quick Explore** icon that appears in the lower right hand corner. In the **Explore** fly-out menu, select among the tables and fields available, and then click **Drill To**. Notice how Excel adds, rearranges, and filters fields in the PivotTable to produce the data view desired. Using Quick Explore in conjunction with the Undo button allows users to quickly drill down and around in a PivotTable report.

**Standalone PivotCharts**

In Excel 2013, PivotCharts can be built without an accompanying PivotTable. Simply select **PivotChart**, **PivotChart** from the **Insert** menu and make sure to check **Add this data to the Data Model** in the **Create PivotChart** dialog box, as shown in **Figure 20**. Click **OK** to display the PivotChart placeholder and the Field List.

![Figure 20 – Creating a Standalone Pivot Chart in Excel 2013](image-url)
Create the PivotChart by dragging fields to the appropriate drop areas in the PivotChart Field List. Resize, filter, and format the chart as required to complete the chart. A "hidden" PivotTable summarizes the data for this PivotChart just as for any other, but the PivotTable is contained in Excel’s in-memory Data Model. Furthermore, the PivotChart can be copied or moved to another workbook without affecting a user's ability to modify the chart. This allows end users to use the chart for analysis without the obtrusive PivotTable that normally accompanies a PivotChart.

**Premium Add-ins**

Microsoft delivered four premium Excel add-ins – Inquire, PowerPivot, Power View, and GeoFlow – to users who licensed Office 2013 Professional Plus. Professional Plus is only available as part of a volume license agreement or in Office 365 subscription plans for Midsize and Enterprise businesses. All of the add-ins have been released except GeoFlow, which is still in beta at this writing.

**Inquire**

Inquire is a Microsoft add-in for Excel 2013 that allows users to compare versions of a workbook, check workbooks for problems and inconsistencies, and identify links between workbooks or worksheets. In a nutshell, Inquire allows users to analyze, review, audit, and document their workbooks. By using Inquire, users will better understand the design and function of their workbooks, along with potential errors, data dependencies, and security concerns.

If the INQUIRE tab does not appear in the ribbon, enable the add-in in Excel. Click File, Options, Add-ins, select COM Add-ins in the Manage box in the pane on the right, and then click Go. Check Inquire in the COM Add-ins dialog box and click OK to enable the add-in, which will now appear in the ribbon, as shown in Figure 21.

![Figure 21 – Inquire Functionality Available from the Ribbon](image)

The primary means of analyses available in Inquire are 1) a tool to analyze workbooks and provide textual summary reports, 2) tools to identify and provide a graphical map of relationships among workbooks, worksheets, and cells, 3) a link to Spreadsheet Compare (a separate application that is included with Office 2013 Professional Plus) for comparing workbook files, 4) a tool to remove excess formatting from empty cells in worksheets or workbooks, and 5) a password manager to ease the burden of analyzing password-protected files. The Inquire tools can be used in conjunction with or as a supplement to the formula auditing and evaluation tools available in all versions of Excel.
**Workbook Analysis** produces a comprehensive analysis of the workbook, sheet by sheet and cell by cell. The **Summary** section identifies any linked workbooks or data connections used by the workbook, provides a history of the file (author, creation date, last modification date), and identifies the number of hidden and unhidden sheets. Other sections comprehensively document formulas, cells, ranges, and warnings. Check any areas for which additional scrutiny is desired, such as formulas with errors or the workbook summary, and then click the **Excel Export** button to export the details to a separate analysis workbook. Click **Load Export File** to open the analysis workbook, which contains the selected details and a column for reviewer comments, as shown in **Figure 22**. For complete and comprehensive documentation of a workbook, check **Items** in the Workbook Analysis Report before exporting it to Excel.

**Figure 22 – Producing the Workbooks Analysis Report**

**Workbook Relationship** produces a graphical map of all other workbooks to which the current workbook links. Likewise, **Worksheet Relationship** provides a graphical map of all other worksheets to which the currently active worksheet links. As shown in **Figure 23**, **Cell Relationship** allows users to visualize how other cells and ranges link to the currently selected cell. All of these tools are similar in the way they portray relationships and interact with a user. Any node on the map – workbook, worksheet, cell, or range of cells – can be repositioned on the map by clicking and dragging the node to another position. The arrows indicated the direction of the relationship between the nodes. To better identify dependents or precedents, right-click on a node and select **Highlight Dependents** or **Highlight...**
Precedents from the context-sensitive menu. Dependents will be highlighted in red and precedents will be highlighted in blue. Selecting Layout Children will display the nodes in a pre-defined pattern.

**Figure 23 – Cell Relationship Map**

Right-clicking the diagram's background allows users to zoom in or out on the map, adjust the layout to a pre-defined pattern, or remove highlights from the diagram. Hovering over a node activates a balloon popup that displays more detail about the node. Point to a node and click the plus sign (+) or minus sign (−) to expand or collapse the map from that node.

**Compare Files** evaluates two Excel workbooks and identifies cells that are different. **Clean Excess Cell Formatting** provides users with a tool to clean unwanted formatting from blank cells, which is a common cause of bloated files and poor performance. Lastly, the Workbook Passwords feature is used to save workbook passwords. This relieves users of having to log in to password-encrypted linked files when running an analysis or file comparison in Inquire.

**PowerPivot 2013**

PowerPivot is a data analysis and reporting tool that delivers business intelligence (BI) capabilities from within Excel. Its familiar, user-friendly interface allows users to generate rich and interactive analyses quickly and easily, which shortens decision cycles and helps achieve deeper business insight.
The process for creating PivotTables and PivotCharts in PowerPivot is identical to the process of creating ordinary PivotTables and PivotCharts, with two major exceptions: 1) PivotTables and PivotCharts created in PowerPivot can have multiple data sources, and 2) PowerPivot uses an in-memory data engine and efficient compression algorithms to process huge data sets with extraordinary performance. Users can process millions of rows with nearly the same performance as a few hundred rows.

To begin working with PowerPivot, open a new Excel workbook. Then, click Manage on the PowerPivot tab to open the PowerPivot for Excel window. Think of the PowerPivot window as the data window. It’s a visual representation of the Excel Data Model, where all data to be analyzed is stored and where data from multiple sources can be imported and related. Data connections can be made to a wide variety of common databases, from Microsoft Access to Oracle.

Data imported into the PowerPivot window is stored within the Excel workbook. It is saved with the workbook and will be available when the workbook is reopened. PowerPivot maintains links between the imported data and the original data sources. Data sources can be added, removed, related, or refreshed from within the PowerPivot window. This provides a major advantage to knowledge workers who analyze updated data from the same data sources on a regular basis.

In our example, a PivotTable report will be constructed with data imported from two Microsoft Access databases. In the PowerPivot window, click Home, From Database, From Access to open the Table Import Wizard, as shown in Figure 24.

![Figure 24 – Importing Data from an Access Database](image)
In the first pane of the wizard, click **Browse** and then select the desired database, in this case **ContosoSales**. Click **Next** to open the second pane of the wizard. Choose **Select from a list of tables and views to choose the data to import** and click **Next**. Select the following tables: **DimChannel**, **DimDate**, **DimProduct**, **DimProductSubcategory**, **DimPromotion**, and **FactSales**.

If you are unsure which tables contain the data elements that you need, click **Preview & Filter**, which will allow you to see the data within each table and also allow you to filter the data to include just the required records. If you are unsure as to whether you may need data stored in tables related to those selected, click **Select Related Tables**, and PowerPivot will select related tables automatically. Click **Finished** to open the final pane in the wizard – the **Import Status** dialog box – and begin the data import. When the data is imported successfully, click **Close** to display the tables in the PowerPivot window, as shown in **Figure 25**. Each table will be displayed on a single tab. Note that the FactSales table contains nearly 2.3 million records.

![Figure 25 – Populating the PowerPivot Window with Imported Data](image)

In this example, we will be building a report that displays sales by product category by year. Unfortunately, the product category information is stored in another database, so we need to import more data. Having to build reports from data stored in two or more databases is a common problem in
many companies. For example, it's not unusual for accounting information stored in the G/L to be matched with production or scheduling information stored in another system. PowerPivot allows users to overcome this obstacle by allowing them to import and relate data from multiple sources.

Importing the new data will follow the same process as the one used for the previous set of tables, except this time the name of the database to be imported is **ProductCategories**, which contains a single table. Once the data is imported, the data must be related so that the information in one table is logically linked to the information in the others. To begin the process, click **Design, Manage Relationships** to open the **Manage Relationships** dialog box, as shown in Figure 26.

![Figure 26 – Managing Table Relationships in PowerPivot](image)

Note that several table relationships already exist. That's because PowerPivot detects and re-establishes existing relationships among tables automatically on import. In this case, however, we need to create a new relationship between the DimProductSubcategory table (created in the first data import) and the DimProductCategory table (created in the second data import). Click **Create** to open the **Create Relationship** dialog box. From the **Table** drop-down box, select **DimProductSubcategory** and then from the **Column** drop-down box, select **ProductCategoryKey**. Next, from the **Related Lookup Table** drop-
down box, select **DimProductCategory** and then from the **Related Lookup Column** drop-down box, select **ProductCategoryKey**, as shown in **Figure 26**. Click **Create** and then **Close** to complete the process.

Now that the data has been imported and the tables related, it's time to create a PivotTable report. The process for creating PivotTables and PivotCharts using PowerPivot is identical to creating ordinary PivotTables and PivotCharts in Excel. To begin the process, click **PivotTable** on the **Home** tab, and then select the type of PivotTable or PivotChart to create. **Figure 27** shows a simple PivotTable report produced from the PowerPivot data model.

<table>
<thead>
<tr>
<th>Sales $</th>
<th>FY 2007</th>
<th>FY 2008</th>
<th>FY 2009</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>$29,734,671.91</td>
<td>$52,932,396.05</td>
<td>$68,947,296.35</td>
<td>$151,614,364.31</td>
</tr>
<tr>
<td>Cameras and camcorders</td>
<td>$1,102,593,317.48</td>
<td>$817,903,832.17</td>
<td>$641,426,024.41</td>
<td>$2,562,023,774.06</td>
</tr>
<tr>
<td>Cell phones</td>
<td>$363,847,591.08</td>
<td>$254,836,622.07</td>
<td>$273,552,011.15</td>
<td>$892,233,264.30</td>
</tr>
<tr>
<td>Computers</td>
<td>$1,146,469,996.57</td>
<td>$990,173,504.70</td>
<td>$1,072,783,640.15</td>
<td>$3,209,427,141.42</td>
</tr>
<tr>
<td>Music, Movies and Audio Books</td>
<td>$74,975,760.83</td>
<td>$53,303,972.44</td>
<td>$37,524,972.71</td>
<td>$165,804,705.98</td>
</tr>
<tr>
<td>TV and Video</td>
<td>$426,671,354.26</td>
<td>$473,265,849.61</td>
<td>$460,183,910.90</td>
<td>$1,360,121,114.76</td>
</tr>
<tr>
<td>Grand Total</td>
<td><strong>$3,144,393,292.13</strong></td>
<td><strong>$2,642,413,217.03</strong></td>
<td><strong>$2,554,417,855.67</strong></td>
<td><strong>$8,341,224,364.83</strong></td>
</tr>
</tbody>
</table>

**Figure 27 – PivotTable Report Built on 2.3 Million Records Using PowerPivot**

**Power View**

Power View can be viewed as an extension of PowerPivot because it uses the Excel Data Model as its data repository. It is an interactive data visualization, exploration, and presentation application that provides intuitive ad-hoc reporting for business users such as data analysts, decision makers, and information workers. Power View lets users create interactive reports or dashboards with tables, charts, geographic maps, slicers, and other data visualizations on a single Power View sheet. An Excel workbook can contain a portfolio of multiple Power View reports.

In our example, we will construct a simple Power View report from the Data Model built earlier for the PowerPivot example, extended to include two additional data sources. The two new data sources are Excel files – **DimStores** and **DimGeography** – that contain information about the stores and geographical locations in which sales revenue is earned. After the data from these files are imported into the PowerPivot window, relationships must be established. The **DimStores** table is related to the **FactSales** table on a field named **StoreKey** and the **DimGeography** table is related to the **DimStores** table on a field name **GeographyKey**. Once the Data Model has been updated, we are ready to create a report.

To begin the process, close the PowerPivot window and then click **Insert, Power View** from the Excel ribbon to insert a blank Power View sheet or report canvas. Note that the report canvas is not an ordinary Excel worksheet. Furthermore, the commands available from the ribbon to act on ordinary worksheets are disabled. On the right side of the canvas are two task panes. One, the **Power View Field List**, is similar in appearance and operation as the PivotTable Field List for creating and manipulating PivotTables. The other, the **Filters View**, is where filtering is applied to the report.
Click on the report title placeholder and type in a name for the report. In this case, name the report "US Sales by State." Now add the first report element. Expand the FactSales table in the field list and check the SalesAmount field to add a table containing total sales to the report canvas. All report elements, known as data visualizations, are added first as tables, but can be changed to another form, such as a chart or a map, etc. Resize the element as required. Next, filter the report to include only US sales. Collapse FactSales and expand the DimGeography table. Drag the RegionCountryName field to the Filters View task pane. Check United States and then collapse the field list to filter the report to US sales only. Note that the value in the SalesAmount table changed after the filter was applied. The report should resemble the one shown in Figure 28.

![Figure 28 – Report Canvas, Filters View Task Pane, and Power View Field List](image)

The next element will be a map that identifies the relative amount of sales by state. Expand the DimGeography table in the field list. Making sure that no other element on the report canvas is selected, drag the StateProvinceName field to the left side of the canvas to produce a tabular list of states. Collapse DimGeography and expand FactSales. With the list of states selected, check
SalesAmount in the field list or drag SalesAmount to the canvas and drop it into the list of states to produce a table that displays sales by state. To use GeoView to map the sales data, select the table and click Map on the Design tab. Confirm the request to communicate with Bing Maps to get the geographic coordinates of the data. Once the map is displayed, adjust the size, zoom, and position of the map as required. The completed map should look similar to the one displayed in Figure 29.

![Design tab with Map option selected](image)

**Figure 29 – Using a GeoView Map to Display Data in Power View**

The next steps are to add a bar chart to display the relative amount of sales in each state and add a slicer so that end users can select the reporting year. To add a bar chart that displays sales in each state, repeat the steps for adding the GeoView map up to the point where the map visualization is applied. At that point, select Bar Chart, Clustered Bar on the Design tab. Reposition the bar chart to the right of the map and resize the chart so that the data for all of the states is displayed.

To add a slicer to the report canvas, expand the DimDate table in the field list. Making sure that no visualization is selected on the report canvas, check FiscalYearLabel to add a table of fiscal years to the canvas. While the table is selected, click Design, Slicer to create a slicer from the table. Note that the slicer contains a button for each fiscal year from 2005 to 2011. To filter the slicer to display only years 2007 through 2009, drag the FiscalYearLabel field to the Filters View task pane. Check FiscalYear 2007,
FiscalYear 2008, and FiscalYear 2009 to filter the slicer accordingly. Reposition and resize the slicer as required. The completed report should resemble the one shown in Figure 30.

Figure 30 – Completed Interactive Power View Report

Note that the data visualizations created in Power View are interactive. When a report user selects a fiscal year in the slicer, all of the data visualizations update to display the data for the year selected. When a user clicks on a bar in the bar chart, all other bars are dimmed, the sales amount adjusts to display the revenue earned in the selected state, and the circle in the GeoView map representing the selected state in the bar chart remains brightly colored while the other circles are dimmed. All the elements on the report are interconnected by Power View and are filtered in unison. To clear the filter, click in the bar chart background. Similarly, a user can click on a circle in the GeoView map and filter the bar chart in the process. To filter a single visual element, select the element and click the filter funnel that appears in the upper right hand corner of the element. Then, apply the filter in the Filters View task pane.

New Functions
Excel 2013 introduces fifty-two (52) new worksheet functions. Most are mathematical, statistical, or engineering related. There are two new financial functions. **RRI** returns an equivalent interest rate for
the growth of an investment, and **PDURATION** returns the number of periods required by an investment to reach a specified value. Several other functions may be of interest to accounting and finance professionals. **FORMULATEXT** returns the formula at a given reference as text, which would allow users to confirm that a displayed value resulted from a calculation rather than from a typed-in constant. **NUMBERVALUE** converts text into a number, which may be useful in working with exported reports. In addition to these functions, Excel also debuts functions for accessing web data and for creating calculated columns and fields in the Excel Data Model. To see a complete list of worksheet functions, search the web for "Excel 2013 new functions."

**Web Data Functions**

Among the fifty-two new worksheet functions are three functions – **ENCODEURL**, **FILTERXML**, and **WEBSERVICE** – for retrieving data from the web. These functions can be used to retrieve data from any web site that delivers RSS feeds. Data retrieved in this manner are always up to date because the update is delivered by the web site. **ENCODEURL** returns a URL-encoded string. It allows users to build a URL with formulas, so that a user could enter a zip code in a cell and return the weather forecast for that location. **WEBSERVICE** returns data from a web service, which can be specified manually or by reference to a URL encoded by ENCODEURL. **FILTERXML** returns specific data from the XML content delivered by a web service using a specified identifier known as an XPath. **Figure 31** shows an exchange rate table retrieved from a web service.

![Figure 31 – Exchange Rate Data Retrieved Using the Web Data Functions](image)

**DAX Functions**

With the debut of the Excel Data Model, Microsoft released new functions for calculating columns and fields in data model tables. The new functions are for building Data Analysis Expressions (DAX). There
are 131 DAX functions in Excel 2013. Eighty-two functions are for creating calculated columns in a data model. Most of these functions are identical in operation and syntax as ordinary Excel worksheet functions, with a few notable exceptions, as outlined in the table below.

<table>
<thead>
<tr>
<th>Excel Function</th>
<th>DAX Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEXT</td>
<td>FORMAT</td>
</tr>
<tr>
<td>SUMIFS</td>
<td>CALCULATE</td>
</tr>
<tr>
<td>VLOOKUP</td>
<td>RELATED</td>
</tr>
<tr>
<td>CHOOSE</td>
<td>SWITCH</td>
</tr>
</tbody>
</table>

Fifty-four functions are used to calculate measures, known as calculated fields in a PowerPivot PivotTable report. Measures are used to aggregate data. Those familiar with OLAP cubes will understand the term. The importance of these functions is that the calculation takes place in the PivotTable, not in the raw data. A calculated column in a data table with two million records makes the imbedded calculation two million times, once for each record. On the other hand, a similar calculation made using a calculated field in a thirty row PivotTable makes the calculation thirty times, notwithstanding that the PivotTable is based on two million records. Measures are much more computationally efficient than calculated columns.

In our first example, we will calculate a column in the data model used earlier for the Power View report. Recall that we used the FiscalYearLabel field as a report slicer. The values in the field were FiscalYear 2007, FiscalYear 2008, and FiscalYear 2009, but we want the slicer to read FY 2007, FY 2008, and FY 2009. In order to accomplish this goal, we must first create a calculated column and then place it on the report as a slicer.

First, open the workbook that contains the Power View report. Select PowerPivot, Manage to open the PowerPivot window. Click on the DimDate tab at the bottom of the window. Scroll to the far right hand side of the table so that you can see a column labeled Add Column. Click in the column's first cell and type this DAX expression in the formula bar at the top of the data grid:

```
="FY "&Format([FiscalYear],"General Number")
```

Press ENTER and wait while PowerPivot makes the calculations. Click in the column heading and rename the column to FYear. Save the changes and exit PowerPivot. Click on the Power View report created earlier. On the report canvas, select the FiscalYearLabel field as a report slicer. The values in the field were FiscalYear 2007, FiscalYear 2008, and FiscalYear 2009, but we want the slicer to read FY 2007, FY 2008, and FY 2009. In order to accomplish this goal, we must first create a calculated column and then place it on the report as a slicer.

First, open the workbook that contains the Power View report. Select PowerPivot, Manage to open the PowerPivot window. Click on the DimDate tab at the bottom of the window. Scroll to the far right hand side of the table so that you can see a column labeled Add Column. Click in the column's first cell and type this DAX expression in the formula bar at the top of the data grid:

```
="FY "&Format([FiscalYear],"General Number")
```

Press ENTER and wait while PowerPivot makes the calculations. Click in the column heading and rename the column to FYear. Save the changes and exit PowerPivot. Click on the Power View report created earlier. On the report canvas, select the FiscalYearLabel field as a report slicer. Press DELETE to remove the slicer. In the Power View Field List, expand the DimDate table and then check FYear to place a table on the report canvas. While the FYear table is selected, click Slicer on the Design tab to convert the table to a slicer. Note that the filtering applied earlier to the report is still active and the slicer labels now read as desired. Figure 32 displays the slicer in the report after the calculated column and report modifications were completed.
In our final example, we will create a calculated field (a measure) using DAX functions and apply it to a PowerPivot PivotTable report. We will use the same data model used the in the previous example. Open the PowerPivot window and create a simple PivotTable report from the following tables and fields.

<table>
<thead>
<tr>
<th>Table</th>
<th>Field</th>
<th>Drop Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>DimGeography</td>
<td>StateProvinceName</td>
<td>Rows</td>
</tr>
<tr>
<td>DimGeography</td>
<td>RegionCountryName</td>
<td>Filters</td>
</tr>
<tr>
<td>FactSales</td>
<td>SalesAmount</td>
<td>Values</td>
</tr>
<tr>
<td>DimStores</td>
<td>SellingAreaSize</td>
<td>Values</td>
</tr>
</tbody>
</table>

Now create a calculated field to display sales revenue per square foot of selling space. From the ribbon, select **PowerPivot, Calculated Fields, New Calculated Field** to open the **Calculated Field** dialog box. Select **FactSales** as the **Table name** and enter **Sales per SqFt** as the **Calculated field name**. In the **Formula box**, enter the following formula:

\[
=\text{SUM}(\text{FactSales}[\text{SalesAmount}]) / \text{SUM}(\text{DimStores}[\text{SellingAreaSize}])
\]

Set the **Formatting Options** to **Currency** with $ signs and 2 decimals. Make sure to check the formula for errors before creating the new calculated field. Click **Check formula** and wait until PowerPivot performs the check. If the check is successful, PowerPivot will report **No errors in formula**, as shown in **Figure 33**. Click **OK** to add the calculated field to the FactSales table and to the PivotTable report. The calculated field will be available for use in any other PivotTable or Power View reports built on this data model. Format the PivotTable and rename columns to meet your reporting needs and the report is complete.
Figure 33 – Creating a Calculated Field in PowerPivot